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About this Guide

Objectives
• Provide information on using ShoreTel Conferencing.

Audience
• ShoreTel Conferencing users.

Organization
• Separated into major tasks, presented in the order in which they should be completed.

ShoreTel Documentation Overview
• ShoreTel system is documented as described in the following sections.

System Documentation
• Conferencing User Guide

Provides information on how to plan the implementation of the ShoreTel Service 
Appliance 100 (SA-100), as well as how to install the hardware and configure the 
integrated applications. 

• Planning and Installation Guide 

Provides information on how to plan the implementation of the ShoreTel system, as 
well as how to install the hardware, data communications, and telecommunications 
hardware and software.

Software Documentation
• ShoreTel Administration Guide

Provides detailed reference information (both task-based and screen-by-screen) on 
how to administer and maintain the ShoreTel system using ShoreTel Director. 

• ShoreTel Server Software Release Notes

Provide information about new releases, new features, installation, and upgrading for 
the ShoreTel server.
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Hardware Documentation
• Following installation documents are packaged with the associated ShoreGear voice 

switch, ShoreTel Service Appliance 100, or ShorePhone IP phone:

— Quick Install Guides for each ShoreTel Voice Switch
— Shoretel Service Appliance 100 Quick Install Guide
— Quick Install Guide for each ShorePhone IP phone

User Documentation
• End-user documentation is installed during the ShoreTel Communicator installation. It 

is available through the Help > Contents and Index command in ShoreTel 
Communicator.

Online Knowledge Base
• To access additional information about the current release or to resolve issues with the 

ShoreTel system, you can use the ShoreTel online knowledge base.

• This password-protected, online database is accessible to authorized contacts through 
the ShoreTel web site at www.ShoreTel.com.

Document Conventions
• Conventions used in this guide include the following:

— Data-entry field names, hypertext links, control buttons, keywords, and other 
items within the system management interface are in boldface text.

— Information that you enter in data-entry fields is in a data_entry font.

http://www.shoretel.com
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C H A P T E R 1

ShoreTel Conference Web: Overview

1.1 Introduction
ShoreTel Conference Web provides an easy-to-use tool for hosting and attending conferences, 
sharing desktops or applications (including presentations), and recording conferences.

Conferences can be web and audio, web only, or audio only.

ShoreTel Conference Web runs in a standard Web browser and does not require installation of 
any special software if your computer is running ShoreTel Communicator.

1.2 Hosting a Conference
As a ShoreTel Conference Host, you can:

• Create new conferences and edit and delete existing conferences.

• Lead a conference and give presentation rights.

• Browse a list of conferences and conference owners.

• Manage library content for conferences.

• View details about your conferences.

• Play or download recordings.

1.3 Participating in a Conference
As a ShoreTel Conference participant, you can:

• Access a conference by following instructions on a conference invite.

• Access and view listing of available public conferences.

• View and play available recordings.

1.4 Conference Interface
ShoreTel Conference Web is accessible through three user interfaces: Conference Viewer, 
Conference Web Portal, and Conference Administration Site.

NOTE ShoreTel Conference Web may also be accessed from Outlook and ShoreTel 
Communicator for Windows.
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1.4.1 Conference Viewer
• Used primarily by hosts to schedule, start, delete conferences and access their 

recordings.

1.4.2 Conference Web Portal
• Used primarily by hosts to schedule, start, delete conferences and access their 

recordings.

1.4.3 Conference Administration Site
• Allows an Administrator to configure web site parameters, establish default 

conference parameters, and also view and generate web conference reports.

1.5 ShoreTel Web Conference Features
Table 1-1 ShoreTel Web Conference Features

Conference Management Conference Audio Conference Web
• Scheduled, instant, and reservationless 

conference

• Customizable host and participant 
access codes

• Audio and Web conference Recordings/
Playback

• Secure Conference Web: 

Encrypted Web conferences (HTTPS)

Encrypted audio conferences (SRTP)

7-Digit access

Conference locking

Requiring a password to join a Web 
conference

• Outlook scheduling

• HD audio

• Telephone user interface (TUI) with 
wide number of commands

• Call participant

• Integrated conference button on 
ShoreTel IP phone

• Resilient Conference Web

• Zero install for participants

• Zero install for hosts using ShoreTel 
Communicator

• Application and desktop sharing

• Application and desktop sharing 
recording/playback

• Shared and Private library

• Whiteboard

• File transfer

• Conference Chat

• Support for Microsoft PowerPoint and 
any Flash document

• Resilient Conference Web
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C H A P T E R 2

ShoreTel Conference Web Portal

2.1 Introduction
From the ShoreTel Conference Web Portal, you can create conferences, upload files for use in 
conferences, create a user profile, and more.

NOTE If you are on a system with Audio Conference licenses only, you cannot upload files.

Depending on the settings of your ShoreTel system, you are presented with one of the 
following web portals when opening up the ShoreTel Conference Web Portal:

• The ShoreTel conference Web portal for Web and audio:

— Opened when the system supports both conference Web and conference audio.

• The ShoreTel conference Web portal for audio:

— Opened when the system supports conference audio only.

2.2 Accessing ShoreTel Conference Web Portal
You can access the ShoreTel Conference Web portal from a Web browser (page 12) or from 
ShoreTel Communicator (page 15).

Microsoft Internet Explorer 9.0 or later, Firefox 12.0, or Safari 5.0 is required to access the 
ShoreTel Conference Web Portal from a browser.

If you are logged into ShoreTel Communicator, you can access the ShoreTel conference Web 
portal by clicking Window->Conference Web Portal.
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2.2.1 Accessing Portal from a Web Browser
When accessed from a Web browser, the ShoreTel Conference Web portal opens at the Public 
page.

From there, you log into the My Conferences page.

To log into My Conferences, you need the following:

• Your ShoreTel user ID.

• Your ShoreTel conference password.

NOTE Ask your ShoreTel system administrator for the password, if you do not know 
it. 

2.2.1.1 Logging into the Web Portal

Step 1 Launch a supported browser.

Step 2 In the Address field, type the URL for the ShoreTel Conference application.

NOTE Ask your ShoreTel system administrator for the URL, if you do not 
know it. 

The ShoreTel conference Web portal is opened to the Public page for systems 
supporting conference audio and conference Web (Figure 2-1) or for systems 
supporting conference audio only (Figure 2-2).

Step 3 Click Sign In in the upper right hand corner of the page.

The Sign In page is displayed (Figure 2-3).

Step 4 Enter your ShoreTel user ID.

Step 5 Enter your ShoreTel password.

NOTE The password must consist of standard ASCII characters. Non-ASCII 
characters are not supported.

Step 6 Click the Sign In button.

The My Conference page is displayed (Figure 2-4).

It is the home page for almost all of your conference activities.

NOTE The first time you sign into the Web portal, you must set the time zone for 
your conference device (Figure 2-5). Select your local time zone. The system 
automatically adjusts conference times to your local time.
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Figure 2-1 Web Page for Web and Audio

Figure 2-2 Web Page for Audio Only
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Figure 2-3 Sign In Page

Figure 2-4 My Conferences Page
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Figure 2-5 Set Time Zone Page

2.2.2 Accessing Web Portal from ShoreTel Communicator

Step 1 Launch ShoreTel Communicator.

Step 2 Click Windows > Conference Web Portal (Ctrl+Shift+K). (Figure 2-6)

The ShoreTel conference Web site is opened in your default browser.
(Figure 2-7)

Depending on how your system is configured, the audio and Web version of the 
My Conferences page is displayed, or the audio only version of the My 
Conferences page is displayed.

NOTE The first time you sign into the Web portal, you must set the time zone for 
your conference device (Figure 2-5). Select your local time zone. The system 
automatically adjusts conference times to your local time.



Conferencing User Guide Chapter 2: ShoreTel Conference Web Portal

16

Figure 2-6 Access Conference from Communicator
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Figure 2-7 My Conferences Page Accessed from Communicator
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2.3 My Conferences
From here, you can create and manage your conferences.

If you receive a conference invite, follow the instructions in the message to join a conference, 
which direct you to My Conference.

If you are logged into the Web portal, join a conference via My Conference.

My Conferences includes four pages: "Conferences", "Recordings", "Conference Options", 
and "Comments".

2.3.1 Conferences
From here, you can create and view conferences (Figure 2-8, Figure 2-9, Table 2-1).

2.3.1.1 Accessing Conferences

Step 1 Click Conferences.

The Conference page is displayed.

NOTE You can also join a conference by entering the access code for the 
conference in the Access Code field.

Figure 2-8 My Conferences Tab Web and Audio
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Figure 2-9 My Conferences Tab Audio Only

Table 2-1 My Conferences

Add a Conference Create a new conference. Launches Add a Conference page; from here, you can create 
one-off conferences and recurring conferences.

Download Presenter Software

(Not applicable in audio only Web 
page)

Download ShoreTel Presenter for Windows. It is optimized for Windows computers. A 
computer must have a presenter to share data. Java 1.6.0.15 Runtime Environment can 
also be used to perform presenter functions.

Access Code Lists numbers used by the system to identify conferences. The system automatically 
generates an access code for each new conference (which can be edited). This number is 
used by participants to join the conference.

Today’s Conference Lists conferences scheduled for today. 

Conferences Lists conferences scheduled for days after today.

Date Date of scheduled conference, including date for recurring conferences.

Invite Access e-mail message automatically sent by the system to specified conference 
participants. 

Edit Modify conference parameters. Only conferences created in the ShoreTel conference 
Web portal can be modified. Conferences created in Microsoft Outlook or another 
calendar can be modified only in those applications

Join Join a conference.

Set default time zone Specify your local time zone. All conference information is adjusted to your local time, 
including conferences schedule in different time zones.

Warning. Read associated message.

Recurring conference.



Conferencing User Guide Chapter 2: ShoreTel Conference Web Portal

20

2.3.2 Recordings
From here, you can view, play, download, edit, and delete conference recordings.

You can also invite conference participants to listen to and view recordings.

2.3.2.1 View Recordings

Step 1 Click Recordings.

The Recordings page is displayed (Figure 2-10, Figure 2-11, Table 2-2).

The recordings made by you are listed.

NOTE Recordings made during a conference are automatically added to the 
recordings list.

Figure 2-10 Recordings Web and Audio
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Figure 2-11 Recordings Audio Only

Table 2-2 Recordings

Show Display name and location of recordings.

Go Display contents of selected folder.

Rename folder to Rename recording folder.

Rename Rename recording file.

Delete Delete file.

Move selection Move selected folder from one location to another.

Move Transfer recordings to selected folder. 

Recording ID Automatically assigned to recording session.

Multiple recordings can be made in a conference.

Name Conference name.

Date Date and time recording was made, and duration.

Invite Send recordings as e-mail attachments.

Edit Edit recordings.

Play Play recordings.

Download (web & audio) Download web and audio recordings.

Download (audio only) Download audio recordings.

Set default time zone Specify your local time zone. All conference information is adjusted to this setting.
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2.3.2.2 Access Recordings

Step 1 From Show, select a recording.

Step 2 Click Go.

The recording is displayed.

2.3.2.3 Play Recordings

Step 1 Click Play.

The what is opened (Figure 2-15).

Step 2 Click the buttons to control playback.

Figure 2-12 Recording Tools Dashboard

2.3.2.4 Download Recordings

Step 1 Click Download and follow the prompts.

2.3.2.5 Invite Someone to Listen to or View Recordings

Step 1 Click Invite and follow the prompts.
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2.3.2.6 Edit Recordings

Step 1 Select a recording.

Step 2 Click Edit.

The Update Recording page is displayed (Figure 2-13).

Step 3 Specify Login options.

Step 4 Click Show more options.

The Publish and Comments options are displayed (Figure 2-14).

Step 5 Specify publishing and comments options.

Step 6 Click Submit.

The options are saved.

Figure 2-13 View Recording Page

Figure 2-14 Show More Options Section of View Recording Page
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2.3.2.7 Delete Recordings

Step 1 Select a recording.

Step 2 Click Delete and follow the prompts.

2.3.2.8 Move Recordings from One Location to Another

Step 1 Select a recording (Figure 2-15).

Step 2 Click Move selection to.

Step 3 Select a folder in the drop down menu, or type the folder name in the Untitled 
field.

Step 4 Click Move.

The recording is moved to the new folder.

Figure 2-15 Recordings Page

2.3.2.9 Rename Recordings

Step 1 From Show, select a folder.

Step 2 Type a new name in Rename folder to (Figure 2-16).

Step 3 Click Rename.

Folder is renamed.

Figure 2-16 Show Field in Recording Page
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2.3.3 Conference Options
From here, you can affix a logo to your conference pages and set parameters that affect user 
participation (Figure 2-17, Table 2-3).

Figure 2-17 Conference Options

Table 2-3 Conference Options

Logo Select a logo for display on conference title bar. 
Acceptable file formats: .jpeg, .gif, or .png files.

Reset to default

Participant Participant options:

• Participants can see everyone’s name.

• Participants can send messages to everyone.

• Participants can only send messages to the host.

• Participants can only see the host’s name.

Alert Sound Tone signaling that a participant has joined or left conference.

Exit Page Website browser goes to when participant leaves conference. Enter link to site. 
Default Website is set by your ShoreTel system administrator.

Submit Implement and save your changes.
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2.3.4 Comments
From here, you can make comments public or private, or you can delete them (Figure 2-18, 
Table 2-4, Figure 2-19,).

Figure 2-18 Comments Web and Audio

Table 2-4 Comments

1 Conference Select conference. All comments are displayed.

2 Make Public Make selected comments available to all viewers.

3 Make Private Make selected comments available to specific viewers.

4 Delete Remove comment.

5 Entry Check Box Enable comment entry.

6 Name of Commentator Commentator name.

7 Date and Time Date and time comment was sent.

8 Name of Conference Conference name.

9 Disposition Disposition of comment.

10 Comment Entire posted comment.

11 Count Number of comments listed on current page.
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Figure 2-19 Comments Audio Only
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2.4 Personal Library
From here, you can manage files that can be shared in conferences (Figure 2-20, Table 2-5).

You can add presentations, pictures, audio, and video to your personal (private) or shared 
(public) library.

You can also delete files from the libraries and edit the attributes of the files in the libraries.

Importable file formats include:

• .ppt (PowerPoint)

• .jpeg (photo)

• .flv (Adobe Flash video)

• .mp3 (audio)

Figure 2-20 Personal Library
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Table 2-5 Personal Library

2.4.1 Add Media to Personal or Shared Library

Step 1 Double-click Personal Library or Shared Library.

Library is highlighted and opened.

Step 2 Click/select a destination folder (pictures, presentations, video files, audio files).

Step 3 Click Add.

The Add to library: Personal Library window is opened (Figure 2-21).

Step 4 Select a Media group.

Step 5 Browse to, select, and open the media.

Step 6 In the Add to library: Media Library window, click File Attributes.

The File Attributes window is opened (Figure 2-22).

Step 7 Enter the attributes.

Step 8 Click OK.

The media is uploaded.

Files cannot exceed 12 MB.

Upload time cannot exceed 10 minutes.

NOTE To import .PPT, ShoreTel Presenter for Windows and MS PowerPoint 
must be installed on your local PC.

Fit Window Expand library file section into browser.

Restore Window Revert expanded library view to default library view.

Refresh library Reload library.

Add Add new file to library folder.

Delete Delete a file from library folder.

Edit Add information to file label.

Personal Library Folder Personal (private) folder.

Shared Library Folder Shared (public) folder.

View Panel Viewing area.

Use Presenter Window client Download presenter software for your computer.

Public Open Public tab of ShoreTel conference Web portal.



Conferencing User Guide Chapter 2: ShoreTel Conference Web Portal

30

Figure 2-21 Select File Window

Figure 2-22 File Attributes Window
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2.4.2 Delete Media from Personal or Shared Library

Step 1 Double-click Personal Library or Shared Library.

Library is highlighted and opened.

Step 2 Click/select a destination folder (pictures, presentations, video files, audio files).

Step 3 Click/select a file.

The Delete and Edit buttons are activated (Figure 2-23).

Step 4 Click Delete.

The Deleting dialog is opened.

You are prompted to delete the file.

Step 5 Click Yes.

The media is deleted.

NOTE Personal Library files can be deleted only by the owner of the media. 
Shared Library files can be deleted by anyone.

Figure 2-23 Delete and Edit Buttons Activated
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2.4.3 Edit Attributes of Files in Personal or Shared Library

Step 1 Double-click Personal Library or Shared Library.

Library is highlighted and opened.

Step 2 Click/select a destination folder (pictures, presentations, video files, audio files).

Step 3 Click/select a file.

The Delete and Edit buttons are activated (Figure 2-24).

Step 4 Click Edit.

The Edit Media window is opened.

Step 5 Enter edits.

Step 6 Click Save.

The edits are incorporated.

Figure 2-24 Edit Media Window
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2.5 My Profile
From here, you can upload a picture for your conference host profile.

The picture is displayed in the Public Conferences tab for conferences hosted by you.

The picture is also displayed under Information in the Conference Viewer.

Importable file formats include:

• .jpg

• .gif

• .png

2.5.1 Access and Upload Pictures

Step 1 Click Browse (Figure 2-25).

Step 2 Navigate to a picture file.

Step 3 Click Save.

The picture is displayed in your conference in the upper-right Info panel.

2.5.2 Remove or Replace Pictures

Step 1 Click Browse (Figure 2-25).

Step 2 Navigate to a picture file.

Step 3 Click Save.

The picture is replaced.

NOTE To do what, check Reset Picture.

Figure 2-25 My Profile Tab



Conferencing User Guide Chapter 2: ShoreTel Conference Web Portal

34

2.6 Using Conference Web Portal
Public is the home page of the ShoreTel Conference Web portal.

Public is available to all users.

Use Public to join a conference if you do not receive a conference invite or if you are not 
logged into the Web portal.

NOTE If you receive a conference invite, follow the instructions in the message to join a 
conference, which direct you to the My Conference (page 18). If you are logged into 
the Web portal, join a conference via the My Conference (page 18).

Public features five pages (Figure 2-26, Table 2-6): "Conferences Page", "Recordings Page", 
"System Test Page", "Speed Test Page", "Download Page".

From Public, you can perform the following tasks:

• List conferences available for public access.

• List conference recordings available for public access.

• Verify your computer is set up to use conference Web.

• Verify your computer network connection is adequate for conference Web.

• Download and install ShoreTel presentation tools required to use conference Web.

Figure 2-26 Public Tab



Chapter 2: ShoreTel Conference Web Portal Conferencing User Guide

ShoreTel 13 35

Table 2-6 Public Page

2.6.1 Conferences Page
From here, you can view a list of conferences, join a conference, or post a comment (for 
conferences accepting comments). (Figure 2-27, Table 2-7)

Figure 2-27 Public Conferences

Sign In Log into your personal Web conference portal.

Help Launch online help.

Access Code Conference access code. Enter code, then click Join.

Conferences Display Public conferences page, which lists conferences available to all users. 

Recordings Display conference recordings available to public.

Conference recordings can be downloaded for later listening.

System Test Test if computer is set up to support Web conferencing. 

Speed Test Test speed of network connection between your computer and appliance set up to support Web 
conferencing.

Download Display Download page, which includes links to applications that can be installed to facilitate Web 
conference presentations.
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Table 2-7 Public Conferences

2.6.1.1 List Conferences

Step 1 In the Show field, select a search parameter. 

Step 2 Click Go.

The results are displayed.

NOTE You can also list conferences using the Search field: Enter the name or 
part of the name of a conference or host (or a conference access code), 
then click Search.

2.6.1.2 Join a Conference

Step 1 Click a conference name, or click Join.

For more information about joining a conference, see page 57. 

2.6.1.3 View Information about a Conference

Step 1 Click Info.

A page containing information about a conference (including comments posted to 
the conference Web site) is displayed (Figure 2-28 and Table 2-8).

Show Set search criteria for conferences.

• Today’s conferences.

• In-progress conferences.

• All conferences.

Go List conferences specified by criteria in how field.

Search Search public conference database by conference name, host name, and access code. 

Name Conference name. Conference host is also listed.

Date For scheduled conferences only: Display conference start date, meeting time, and meeting duration.

Info Display conference information, including off-system dial-in number, participant code, and public 
comments. Comments can also be posted here (if a conference is configured to accept comments).

Join Join (or initiate) a conference.
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Figure 2-28 Conference Info Page

Table 2-8 Conference Info

2.6.1.4 Post a Comment (if enabled)

Step 1 Enter a conference.

Step 2 Click Post a comment.

The Comments pane is displayed.

Step 3 In the Comments field, type your comment.

Step 4 In the Name field, type your name. (This field is required.)

Step 5 In the Email field, enter the email address to which you want responses sent.

Step 6 In the Security question field, add the numbers and enter the answer in the field.

Step 7 Click Preview.

Your comment is presented as it will be displayed.

Name Conference name.

Hosted by Conference host.

Join Join conference.

Login Log into conference.

Telephone Number needed to dial into a conference.

Comments Comments made by conference participants (if enabled).

Post a comment Leave a comment. Link not displayed if Comment is disabled.
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Step 8 To remove your comment, click Discard.

The comment is discarded and the Comments pane is closed.

Step 9 To post your comment, click Post comment to public area.

The comment is posted on the conference page.

NOTE You can send a private comment to the conference host by clicking Send 
private comment to host.

2.6.1.5 Set Time Zone (if not already set)

Step 1 In Set default time zone, select the time zone for your location (Figure 2-5).

The Web page is refreshed, and your computer is set to the time zone in which it is 
located, ensuring that conference events reported on the computer are adjusted to 
local time. The default time zone is UTC 12:00.

NOTE You have to set the time zone only once for your computer. The setting 
is common to all ShoreTel conference Web portal tabs and pages on 
your computer.
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2.6.2 Recordings Page
From here, you can view, play, download, and manage recordings (Figure 2-29, Table 2-9).

Figure 2-29 Recordings

Table 2-9 Recordings

Search Enter string. Click to initiate search.

Name Conference name.

Date Date and time recording started, and duration.

Hosted by Conference host.

Info Opens page that provides information about conference.

Play Play recording.

Download (web & audio) Download data and audio.

Download (audio only) Download audio.

Set default time zone Specify local time zone. All conference information is adjusted.
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2.6.3 System Test Page
From here, you can test your computer to ensure that it can run ShoreTel Web conferences 
(Figure 2-30).

Figure 2-30 System Test Page



Chapter 2: ShoreTel Conference Web Portal Conferencing User Guide

ShoreTel 13 41

2.6.4 Speed Test Page
From here, you can test the latency of the connection between your computer and the ShoreTel 
system (Figure 2-31).

NOTE For best results, the latency should be under 100ms.

2.6.4.1 Test Connection between Your Computer and ShoreTel System

Step 1 Click Speed Test.

The Speed Test page is displayed (Figure 2-31). 

Step 2 Click Start Test.

The test is run and the results are displayed.

Figure 2-31 Speed Test
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2.6.5 Download Page
From here, you can download and install the ShoreTel Presenter software required for using 
desktop sharing and for importing PowerPoint presentations during conferences (Figure 2-32).

Two versions of ShoreTel Presenter are available:

• ShoreTel Presenter for Windows

— Enables desktop sharing for Windows users.

— Allows import of PowerPoint presentations.

— Installation required.

— Recommended but Optional: Windows Desktop Accelerator (improves desktop 
sharing performance).

• ShoreTel Presenter for Java

— Enables desktop sharing for all users.

— No installation required.

— PowerPoint presentation import is not supported.

NOTE PowerPoint can be used to export presentation as series of JPEG images. Or, 
third-party program can be used to export presentation as Flash movie.

2.6.5.1 Install ShoreTel Presenter for Windows

Step 1 Click Download ShoreTel Presenter.

Step 2 Save file.

Step 3 Run installer.

Application is installed on your computer.

Install ShoreTel Desktop Accelerator for Windows

Step 1 Click ShoreTel Desktop Accelerator.

Step 2 Save file.

Step 3 Run installer.

Step 4 Reboot your computer.

Accelerator is installed on your computer.

2.6.5.2 Install ShoreTel Presenter for Java

Step 1 Start Desktop Sharing Session.

You are prompted to download a Java application.

Step 2 Download and install the application.

NOTE Java 1.6.0.15 or above is required.
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Figure 2-32 Download Page
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C H A P T E R 3

Creating Conferences

3.1 Introduction
The ShoreTel system allows you to configure conference settings via multiple interfaces.

3.2 Create a Conference
NOTE You can also create a conference in one click with Outlook. See what.

Step 1 Launch ShoreTel Communicator.

Step 2 On the menu bar, click Windows > Conference Web Portal.

Your ShoreTel Conferencing portal is launched in a web browser.

Step 3 Click Set default time zone.

Step 4 Select the time zone for your geographical location.

Step 5 Click Add a Conference.

The Add a Conference page is displayed (Figure 3-1).

Step 6 In Conference Name, enter a name.

The name is referenced in e-mails about conference sessions.

Step 7 In Date/Time, specify conference type:

Reservation-less: ad-hoc.

Schedule: recurring.

Step 8 Select Start Date.

Step 9 Select Start Time.

Time is based on default time-zone parameter set for your conference viewer.

NOTE Time is automatically calculated for remote users.

Step 10 Select Duration.
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Figure 3-1 Add Conference Page

Step 11 For a recurring conference, check Enable recurrence, then specify an interval:

None: One conference.

Daily: One conference every day.

Weekly: One conference one day per week.

Monthly: One conference one day per month.

Step 12 If you want the ShoreTel system to send you an e-mail invitation to the 
conference, check Add to my calendar.

The e-mail includes links for launching the conference portal and the page for the 
conference in your calendar.

You can forward the invitation to others.

NOTE This feature is not supported for recurring conferences.
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Step 13 In Description, describe the conference.

The description is posted in the ShoreTel conference viewer.

Step 14 In Login, specify a method for accessing the conference:

Name: participants can access the conference using their names.

Name/Password: participants can access the conference using their name and the 
conference password. 

In Password, type the conference password. You can use up to eight characters in 
the password.

Step 15 In Dial-in number and Access Code, enter the information needed to access the 
conference.

NOTE The system automatically generates conference access information for 
every new conference.

Step 16 In the Participant Code field, enter the code that you want call participants to use 
to access the conference.

Step 17 In the Host Code field, enter the code that you want the conference host to use to 
access the conference.

Step 18 In Participant Announcement, select the announcement used when a participant 
joins or leaves the conference:

None: no announcement is made.

Tone: a tone is played.

Detailed: participants are prompted for their names when joining; names are 
announced when participants enter and exit.

Step 19 For more conference options, click Show more options (Figure 3-2).

Figure 3-2 Add Conference Page Show More
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Step 20 In Conference Type, specify how the conference should start:

Start the conference only when host joins: participants are placed on hold until 
host joins.

Start the conference only when I join and list the conference on the public page: 
host must join conference and place conference information on Conference portal 
in Public before participants can join.

Start the conference when anyone joins: conference starts after first person joins.

Start the conference when anyone joins and make everyone a presenter: 
conference starts after first person joins, and everyone can present data.

NOTE Conference Type is unavailable for Web conference portal page for audio 
only.

Step 21 In Outdial Prompt, specify whether participants (including host) called from 
conference are prompted to join conference:

Require Prompt: called parties must press 1 to join.

No Prompt: called parties can join without a prompt.

Step 22 In Comments, specify how participants can place comments in conference record:

Allow public comments: participants can record comments directly into 
conference record.

Private comments only: all comments are directed to host for inclusion in 
conference record.

Disable comments: participants cannot place comments in conference record.

Step 23 Click Submit.

Conference is created.
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3.2.1 Set Default Time Zone
The ShoreTel conference Web portal clock, the Default Time Zone, is initially set by the 
ShoreTel Headquarters server.

You must synchronize the clock to your local time zone:

Step 1 Launch the ShoreTel conference Web portal.

Step 2 Sign in.

Step 3 Click My Conferences.

Step 4 Click Conference.

The date and time you logged in is displayed (Figure 3-3).

Step 5 Click Set default time zone (bottom of page).

Time zones are displayed.

Step 6 Select your local time zone.

The page is refreshed, and the time zone is reset.

NOTE If your computer is taken to another time zone, reset the default time zone to 
the new, local time.

Figure 3-3 Login Date and Time
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3.2.2 Invite Conference Participants through ShoreTel Conference 
Web Portal
After a conference is created, you can invite additional participants through the ShoreTel 
conference Web Portal or through your default email application.

NOTE When creating a conference, you can use your Outlook contact list to invite additional 
participants. Your e-mail invite allows you bring up your Outlook with the conference 
invite information.

3.2.2.1 Invite Additional Participants

Step 1 Launch the ShoreTel conference Web portal.

Step 2 Sign in.

Step 3 Click My Conferences. 

Step 4 Click Conference.

Step 5 Select a conference.

Step 6 Click Invite.

Step 7 Enter email addresses or email groups. (Separate each entry a comma.)

The conference name is automatically generated.

The invitation message is automatically generated.

The default message contains:

• Number for audio portion of conference.

• Participant access code for audio portion of conference.

• Link for the web portion of conference.

• Password for conference (if required).

• Conference date, time, and duration.

NOTE To edit the message, highlight text and type new message. The invite 
also displays whatever is configured in Additional Calling Information.

Step 8 Click Send Email or Open My Email.

The email is sent from your default email application.
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Figure 3-4 Invite Participants
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Figure 3-5 Conference Invitation
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3.2.3 Edit Conferences
For an existing conference, use Edit to reschedule a conference, change the description, or 
change other options.

Step 1 Launch ShoreTel conference Web portal.

Step 2 Sign in.

Step 3 Click My Conferences. 

Step 4 Click Conferences.

Step 5 Select a conference.

Step 6 Click Edit (Figure 3-6).

The View Conference Page is displayed.

Step 7 Enter edits.

Step 8 Click Submit.

NOTE Reset resets page to original values. Cancel cancels edit operation.

Figure 3-6 Edit Option for a Conference
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3.2.4 View Conference Page Option
View Conference Page displays a summary of information about a specific conference.

Step 1 Launch ShoreTel conference Web portal.

Step 2 Sign in.

Step 3 Click My Conferences. 

Step 4 Click Conferences.

Step 5 Select a conference.

Step 6 Click Edit.

Step 7 Click View Conference Page (Figure 3-7).

A page providing information about the conference is opened (Figure 3-8).

Figure 3-7 View Conference Page

Figure 3-8 Conference Information



Chapter 3: Creating Conferences Conferencing User Guide

ShoreTel 13 55

Table 3-1 Conference Information Page

3.2.5 Delete a Conference

Step 1 Login to My Conferences.

Step 2 Select a conference.

Step 3 Click Delete.

Step 4 Click OK (conference is deleted), or Cancel (operation is canceled).

NOTE Participants are not automatically notified when a conference is 
cancelled.

Figure 3-9 Conference Listing

Figure 3-10 Conference Deletion Dialog Box

Name The conference name.

Hosted by Identifies the conference host.

Join Button that allows you to join the conference now.

Date/Time The date the conference was created and the time it is scheduled to meet.

Duration Specifies how long the conference sessions are scheduled to meet. Identifies the time zone for 
which the schedule is calibrated.

Download iCalender Allows you to open the configuration page for the conference in the calendar application in which 
the conference was created.

Login Specifies the requirements for participants to join the conference.

Telephone Specifies the phone number participants dial to access the conference. (Often, this number is for 
external callers.)

Participant code Access code participants must use to access the conference.
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C H A P T E R 4

Joining and Hosting a Conference

4.1 Introduction
After a conference has been scheduled, the conference host and participants may join the audio 
and web conferences in one of four ways:

• Participants can click an email link sent when the host scheduled the conference. The 
participant may call the conference number listed on the Audio Conference popup 
screen or have the system call them at a number of their choice.

• A participant can dial directly into an audio conference.

• A host can “conference in a participant” by requesting that the system dial the 
participant’s number from the Conference Viewer.

• A host can add participants users via Phone and via Communicator.

Topics in this chapter include:

• Enforced Conference Schedules section on page 57

• Join a Conference section on page 57

• Host a Conference section on page 66

• End a Conference section on page 81

4.2 Enforced Conference Schedules
When the system uses enforced scheduling, conference beginning and end times are enforced 
when the host does not join the conference. Participants can log into a conference up to 10 
minutes before the start time when the host has not joined. 

If the host does not join the conference, the conference is automatically terminated at the 
scheduled end time. Five minutes before the conference is scheduled to end, a termination 
message is posted on the Web pages of participants. At the appointed time, the session is 
terminated and the participants are redirected to the appropriate Web site.

4.3 Join a Conference
Participants can join the conference by clicking the email link sent by the host or accessing the 
conference through the Public tab.
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4.3.1 Join Conference from Email Invitation
The ShoreTel system can send email messages to parties who are invited to join a conference. 
The message can include information about the conference, access information for dialing into 
the conference, and a link for joining the Web session of the conference.

Step 1 Open the email invitation sent to you by the conference host (Figure 4-1).

Step 2 Dial into the conference:

• “Extension” if dialing from ShoreTel phone system.

• “Local dial in” number if calling from outside ShoreTel phone system.

The system informs you that you have reached ShoreTel conferencing and asks 
for the access code to the conference.

Step 3 Type Participant code, followed by the pound sign.

You may be asked to provide your name.

If you are the first person to join the conference, the system informs you.

If the conference is in progress, the operator is silent.

Step 4 Join the Web session of the conference: Click the link.

The default browser is opened on your device and the ShoreTel Conference page 
is launched.

The name prompt shown in Figure 4-2 may appear.

Step 5 Type your name in the prompt.

Step 6 Click OK.

The Audio Conference dialog box as shown in Figure 4-3 appears over the 
ShoreTel conference Web page. 

Step 7 Select the method you want to use to dial into the conference.

• I’ll call this number: You dial into the audio session of the conference.

• Call me at this number: Type the number where you can be reached; the 
conference calls you.

Step 8 Click OK.

NOTE Click Cancel if you have already dialed in or you do not intend to dial 
into the audio session.

The conference viewer appears as shown in Figure 4-4 for the conference host and 
Figure 4-5 for a conference participant. Your name is listed among the participants 
in the Participant pane in the conference session Web page.

NOTE For information about using Web conference pages, see Conference 
Viewer, starting on page 97.
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Figure 4-1 Sample Email Invitation Message

Figure 4-2 Prompt for Join Web Conference

Figure 4-3 Audio Conference Dialog Box
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Figure 4-4 Conference Viewer for Host

Figure 4-5 Conference Viewer for Participant
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4.3.2 Join Conference from ShoreTel Conference Web Portal
You can join conferences from Public or My Conference.

4.3.2.1 Join Conference from Public

Requirements

• Browsers supported: Microsoft Internet Explore 9.0, Firefox 12.0, Safari 5.0

Step 1 Launch a supported browser.

Step 2 In Address, type the URL for the ShoreTel Conference application (provided by 
your system administrator).

The ShoreTel conference Web portal is opened.

Public is displayed for systems that support audio and Web conferencing (Figure 
4-6) or for systems that support audio only (Figure 4-7).

Step 3 In Show, select a conference:

• In-progress conferences: Display list of conferences in progress.

• Today’s conference: Display list of all conferences scheduled for today.

Step 4 Click Go.

The page refreshes, listing the conferences.

Step 5 In Name, locate the conference that you want to join.

Step 6 Click the name of the conference.

Step 7 Click Join.

The conference session page is launched.

The name prompt in Figure 4-2 may be displayed. If so, go to Figure 4-9. If not, 
go to Figure 4-10.

Step 8 Type your name in the prompt.

Step 9 Click OK.

The Audio Conference dialog box is displayed over the ShoreTel conference 
session page (Figure 4-3). 

Step 10 Select the method you want to use to join dial the audio session of the conference.

— I’ll call this number: You dial into the audio session of the conference.

— Call me at this number: Type the number where you can be reached; the 
conference calls you.

Step 11 Click OK.

NOTE Click Cancel if you have already dialed in or you do not intend to dial 
into the audio session.
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The conference viewer for systems that support audio and Web conferencing is 
opened for the conference host (Figure 4-4) or for a conference participant (Figure 
4-5).

Your name is listed among the participants in the Participant pane in the 
conference session Web page.

NOTE For information about using Web conference pages, see Conference 
Viewer, starting on page 97.

Figure 4-6 ShoreTel Conference Web Page Public Tab for Web and Audio
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Figure 4-7 ShoreTel Conference Web Page Public Tab for Audio Only

Figure 4-8 Prompt for Join Web Conference

Figure 4-9 Audio Conference Dialog Box
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Figure 4-10 Conference Viewer for Host

Figure 4-11 Conference Viewer for Participant
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4.3.2.2 Join or Start Conference from My Conferences

Step 1 Launch a supported browser.

Step 2 In Address, type the URL of the ShoreTel Conference application (provided by 
your system administrator).

The ShoreTel conference Web portal is opened.

Step 3 Click My Conferences.

If you are already signed in, My Conferences is opened.

If not signed in, you are prompted to enter your ShoreTel ID and password. My 
Conferences is then opened.

Step 4 Click the name of a conference.

Step 5 Click Join.

The conference session page is launched, and the Audio Conference dialog box is 
displayed over the session page (Figure 4-3).

Step 6 Select a way to dial into the audio session of the conference.

• I’ll call this number: You dial into audio session of conference.

• Call me at this number: Type the number where you can be reached; the 
conference calls you.

Step 7 Click OK.

NOTE Click Cancel if you have already dialed in or you do not intend to dial 
into the audio session.

4.3.2.3 Join Conference using Access Code

Every conference has an access code for participants and an access code for the host.

The participant code allows the user to join the conference session. The participant code is 
provided in the e-mail invitation and the info page for conferences listed on Public. 

The host code allows the user to manage the conference session. The host access code is 
available in the conference profile.

Step 1 Obtain the participant or host code for the conference.

Step 2 Launch the ShoreTel conference Web portal.

Step 3 In Access Code, enter the access code.

Step 4 Click Join.

If the host access code is entered, the host conference page is launched.

If the participant access code is entered, the participant conference page is 
launched and the conference is either started or is waiting to start.

If a participant is informed that there is no conference, the conference is scheduled 
to start at another time. In this situation, access the conference within five minutes 
of the scheduled start time or when the host has joined the conference.
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4.3.2.4 Conference Session Status

When you join a conference session, the session status is displayed in the session Web page on 
the right side of the toolbar:

• Blank—The conference is in progress.

• “It is too early to start”—Conference is not scheduled to start. Try again later. 

• “Conference started”—You are the first participant.

• “Waiting for conference to start”—You have secured a port but the conference has not 
started. Wait for the conference to start.

4.4 Host a Conference
The host is the owner of the conference profile. The host can manage both the profile and 
conference sessions.

When the host joins a conference, the Web conference page for the host (see Figure 4-4)is 
displayed on host’s desktop. From there, the host can manage the conference session.

The host can share applications, give permission to participants to share applications, 
implement recording the session, have the system dial participants, delete participants from 
the session, end the session, and more.

For information about host conference viewer, see Host Web Conference Page section on page 
97. 

NOTE Conferences can be configured and conducted without a host. In unhosted 
conferences, session management capability is not available, and scheduling is 
enforced if set by the system administrator.

4.4.1 Join Conference as Host
There are two ways to join a conference as a host:

• Log in as Host from inside a Conference:

You are automatically made the host of the session.

• Log in as Host from ShoreTel Conference Web Portal:

You must log in as the host to host the session.

4.4.1.1 Log in as Host from inside a Conference

Requirements

• Your ShoreTel user ID.

• Your ShoreTel user password.

Step 1 Click Login on the ShoreTel conference toolbar.

The Login dialog box is opened.

Step 2 Enter your ShoreTel user ID.

Step 3 Enter your ShoreTel user password. 
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Step 4 Click Sign In.

The browser is refreshed, and the conference host page is opened.

Figure 4-12 Login Dialog Box

4.4.1.2 Log in as Host from ShoreTel Conference Web Portal

Requirement

• Host access code.

Step 1 Access the ShoreTel conference Web page.

Step 2 In Access Code, enter the host access code.

The conference viewer is launched and opened at the host Web page.

4.4.2 Share Desktop
Windows desktops are shared using Windows Presenter. Mac desktops are shared using 
ShoreTel Presenter for Java.

4.4.2.1 Initiating Desktop Sharing

Step 1 After starting the conference, click Share on the conference toolbar.

A drop-down menu is opened.

NOTE If sharing for the first time on Windows, you are prompted to select 
ShoreTel Presenter. From here, follow the prompts.

Step 2 Choose Entire Desktop.

A red “presenter” frame is drawn around your entire desktop.

See Conference Presenter, starting on page 83 for more information about using 
presenter frame.

After desktop sharing is initiated, Presenter provides tools for managing the 
shared desktop.
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Presenter Tools

• Pause: Pause desktop sharing. The central screen is blank until desktop sharing is 
restarted (Figure 4-13).

Figure 4-13 Pause Icon

• Show Menu: Open tools for managing the quality of desktop sharing and applications 
9Figure 4-14 and Figure 4-15).

Figure 4-14 Show Menu Icon

Figure 4-15 Show Menu Drop-down Menu

• Pointer: Point to items on your desktop or in an application (Figure 4-16).

Figure 4-16 Pointer
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• Tools for Managing Image Quality and Screen Resolution:

— Refresh Rate: Determines how much data is transmitted. Options are low, 
medium, and high. Default is medium.

— Image Quality: Determines the image quality of data. Options are low, medium, 
and high. Default is medium.

— My Screen Resolution: Determines the resolution of your screen. Options include 
Original, 1024X768, and 800X600. Setting the resolution can impact how 
participants see your desktop sharing. Default is Original.

— Sharing Help: Explanation for desktop sharing tools.

— Close: Close desktop sharing.

— Choose Sharing Window: Determines how much of your screen you share (Figure 
4-17). Select the application you want to share, or manipulate the presentation 
area you want to share.

Figure 4-17 Choose Sharing Window Icon

Figure 4-18 Choose Sharing Window Menu

4.4.2.2 End Desktop Sharing

• Click Stop icon (Figure 4-19) or Stop button on toolbar as shown in x.

• You can also select Close to end desktop sharing.

Figure 4-19 Stop Icon

Figure 4-20 Stop Button
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4.4.2.3 Share Files from Conference Library

Files stored in the ShoreTel conference Web portal library can be shared during conferences.

The files can be uploaded to a user’s public space (shared library) or personal space (personal 
library).

Files uploaded to the public space can be used by anyone presenting in a conference.

Files uploaded to a private space can be used only by the owner of the personal library.

For information about uploading files to the library, see Personal Library section on page 28.

To share a file from the library:

Step 1 Click the Share button on the toolbar.

The Share menu is displayed (Figure 4-21).

Step 2 Click Personal Library or Shared Library.

• Personal Library: Files uploaded to your personal library in the ShoreTel 
conference Web portal.

• Shared Library: Files uploaded to your public library in the ShoreTel 
conference Web portal.

A list of files is displayed.

NOTE If you are not the host, you must sign into the conference in order to 
display the Personal Library option.

Step 3 Click the file that you want to share.

The file is opened in the conference viewer.

Figure 4-21 Share Menu
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4.4.2.4 Import Presentations

This option allows you to merge PowerPoint files with the whiteboard for presentations that 
you can mark in real time.

When you import a PowerPoint file, the slides are integrated with the whiteboard in the 
conference session. The whiteboard tools are displayed with presentation slides on the 
conference page, and the conference toolbar is modified so you can select the PowerPoint slide 
you want to display.

All participants can use the whiteboard tools to mark slides and select the slide displayed.

Modifications made to the slides using the whiteboard tools are retained as long as the 
conference is in session.

The presenter can import multiple PowerPoint files for a single conference session. The names 
of the files imported by the presenter are listed in the Share menu of the presenter only. Only 
one file can be displayed in the conference viewer at any one time. The files can be used as 
long as the conference is in session, even if the presenter leaves the conference.

NOTE This feature is not supported on Macs.

To import and use a PowerPoint file in a Web conference session:

Step 1 Stop sharing the desktop.

Step 2 Click Share.

The Share menu is opened. 

Step 3 Click Import Presentation.

The Launch Application dialog box is opened (Figure 4-22).

Step 4 Select VPresent, then click OK.

VPresent is the default value.

The Select File dialog box is opened.

Step 5 Navigate to and select a PowerPoint file. 

PowerPoint is launched in the background on the computer.

The presentation slides are loaded and integrated with the whiteboard in the 
conference session.

The integrated page is displayed (Figure 4-23).

Step 6 Repeat Steps 2 through 5 for each presentation you want to import.

NOTE After the slides are loaded, you can close the PowerPoint application.
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Figure 4-22 Launch Application Dialog Box

Figure 4-23 Integrated Web Conference Page with Whiteboard and PowerPoint Slide
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Integrate Presentations

After the slides in the PowerPoint presentation are imported into the conference session, you 
use the ShoreTel conference Web page to present the presentation.

Also, you can use the whiteboard tools to mark presentation slides. 

Presentations are handled independently of each other. When multiple presentations are 
imported into a conference session, only one presentation is loaded into the conference session 
page at a time. The presentation is available to all conference participants having presentation 
privileges. 

To change or display a slide:

Step 1 Locate the field providing information about the presentation between Share and 
More on the toolbar.

Step 2 Click the right arrow to advance to the next slide.

Step 3 Click the left arrow to move to the previous slide.

Step 4 Click the field and select the slide that you want to display.

The screen is refreshed, and the slide is displayed.

To use whiteboard tools:

Step 1 Select a tool.

Step 2 Move the cursor to the point where you want to start marking.

Step 3 Click and drag the mouse as necessary.

Marks are retained until the presentation is closed.

Marks cannot be saved directly, but you can record the Web conference session. 
See Record a Conference section on page 79 for information about recording a 
conference.

Step 4 To adjust the size of the presentation in the Web page, click the field to the right of 
More on the toolbar and select the screen size that you want to use for displaying 
slides.

Step 5 To clear the page without stopping share, click Stop.
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4.4.2.5 Whiteboard

• Presenters can use the whiteboard to create and share drawings.

• Drawings have basic drawing forms (lines, shapes, text, color, and a pointer).

• Drawings can be recorded during a conference.

• Drawing control can be passed from host to participants.

• Multiple whiteboards can be created in the same conference.

• Whiteboards can be deleted, but one whiteboard is always open.

• Stopping a conference cleans up all whiteboard sessions.

• Objects can be moved in the whiteboard.

• You can erase a single object or the entire whiteboard.

Access and Use a Whiteboard

Step 1 Open the conference as host.

Step 2 Click Share.

The drop-down menu is opened.

Step 3 Click Whiteboard.

Step 4 The whiteboard tools are opened on the left side of the conference viewer.

Figure 4-24 shows and identifies the whiteboard tools.

Step 5 To add an additional whiteboard, click + on the toolbar (Figure 4-25).

The arrow keys on either side of the drop-down menu allow you to scroll through 
available whiteboards.

NOTE To save a whiteboard, record the conference.
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Figure 4-24 Whiteboard Tools

Figure 4-25 Whiteboard Spinner
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Delete a Whiteboard

Whiteboards are automatically deleted when you leave a session.

To manually delete a whiteboard:

Step 1 In the field that identifies the whiteboard that is being displayed, select the a 
whiteboard.

Step 2 Click the - (minus sign) icon (Figure 4-26).

A confirmation message is displayed (Figure 4-27).

Step 3 Click Yes.

The page is refreshed, and another whiteboard is opened, or the Share Desktop 
page is displayed.

Figure 4-26 Whiteboard Delete Icon

Figure 4-27 Whiteboard Delete Confirmation Dialog Box

Stop and Restore Whiteboard Sharing

You can stop sharing the whiteboard during a conference session; the whiteboard is removed 
from the viewer. 

You can restore the whiteboard at any time; he latest changes are displayed.

To stop whiteboard sharing:

Step 1 Click Stop.

The conference page is refreshed, and the Start desktop sharing page is displayed.

To restore whiteboard sharing:

Step 1 Click Share > Whiteboard.

The whiteboard is restored in the viewer.
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4.4.2.6 Chat Messaging

The conference host can send messages to everyone in the conference or to individual 
participants.

A participant’s reply can be viewed by all of the conference participants or by an individual 
participant.

To send a chat message:

Step 1 Type the message in the message area (Figure 4-28).

Step 2 Choose the recipient from the drop-down menu.

Step 3 Click the arrow to send the message.

NOTE To view messages, open the message window.

Figure 4-28 Message Text Box

4.4.2.7 Presenter Control

During a conference, the host can delegate presentation controls to any participant.

The participant can then control the following:

• Screen share

• Whiteboard drawing

• Library share

• Send or upload file

• Import presentations (Windows only)

NOTE A host cannot pass audio control to a participant. After a host passes 
presentation control to a participant, the host continues to control the 
participant list (mute, lock etc.). 
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Delegate Presenter Control

Step 1 Highlight a participant.

Step 2 Click Participant Options.

The menu is opened.

Step 3 Select Allow Presenting.

The participant is sent a message prompting for desktop sharing (Figure 4-29).

Control is delegated if the participant clicks Yes.

Figure 4-29 Share Desktop Message box

End Presenter Rights

Step 1 Highlight the participant.

Step 2 Click the Participant Options.

The menu is opened.

Step 3 Select Discontinue Presenting.

The participant is sent a message indicating that the host is taking back control 
(Figure 4-30).

Figure 4-30 Presenter Control Message Box
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4.4.3 Record a Conference
• Only a host can record conference sessions.

• A recording can be started and stopped at any point during the session.

• Multiple recordings can be made of the same session.

• Each recording is assigned a recording ID and is listed under the recording tab in the 
Web conference portal for the conference.

• When Web Conferencing is enabled, audio and Web portions of the conference are 
recorded.

NOTE You can record up to eight consecutive hours in a conference.

4.4.3.1 Start a Recording from a Web Conference Portal

• By default, the name of the recording is the same as the name of the conference.

Step 1 Join a conference as the host.

Step 2 To ensure that the audio portion of the conference is recorded, dial into the 
conference or make sure that someone is dialed into the conference.

NOTE You must stop ShoreTel desktop sharing or any streaming application 
before you can start recording.

Step 3 Click More > Start Recording.

A prompt on the audio session informs participants that the call is being recorded.

When there is no audio session, a message is displayed to inform the host that 
only a Web session is being recorded.

Step 4 Click OK.

Recording is continued.

When desktop sharing is in progress, a message is displayed to inform the host 
that desktop sharing must be stopped or paused to start the recording.

Step 5 Click OK.

Desktop sharing is stopped. 

After the recording is started, restart desktop sharing.

The recording is started.

The Stop Recording button is displayed on the menu bar (Figure 4-31).

Figure 4-31 Stop Recording Button
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4.4.3.2 Stop a Recording from a Web Conference Page

Step 1 Click More > Stop Recording, or click the Stop Recording button.

The stop recording message dialog is opened (Figure 4-32).

Step 2 Click OK.

A confirmation message dialog is opened (Figure 4-33).

Step 3 Click OK.

NOTE When you stop a recording, only the recording is stopped; the audio and 
Web sessions continue. 

Figure 4-32 Stop Recording Message Dialog Box

Figure 4-33 Stop Recording Confirmation Message

4.4.3.3 Start and Stop a Recording from an Phone

• A host can start and stop a recording using the keypad of a ShoreTel phone.

• Both audio and Web portions of the conference are recorded.

• To use the ShoreTel phone to start and stop recording a conference:

Step 1 Join the conference as the host.

NOTE Use the host access code when dialing into the conference.

Step 2 On the keypad, press # then 4.

The audio participants are informed that the conference is being recorded.

Step 3 To stop the recording, press # then 4.

The audio participants are informed that the recording has stopped.
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4.5 End a Conference
• Only the host can end a conference.

• If the host does not participate in a conference or leaves early, the conference is 
terminated after the last participant exits.

• Participants may leave a conference at any time. Participants are not required to log 
out of a conference.

• To leave a conference, close the conference browser window.

To end a conference:

Step 1 Join the conference as host.

Step 2 Click More > End Conference. 

A confirmation message box is opened.

Step 3 Click OK.

Participants are notified, and the conference is ended.
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C H A P T E R 5

Conference Presenter

5.1 Introduction
ShoreTel Presenter enables a conference participant to share desktop content with other 
conference participants.

Sharing is possible only if ShoreTel Presenter is installed on the computer sharing the desktop 
and the computer(s) receiving the shared content. (ShoreTel Presenter is automatically 
installed with ShoreTel Communicator.)

Only one participant can present at a time. Depending on the configuration of the conference, 
the default presenter is the host. (The host can give permission to other participants to share 
their desktop, or the conference can be configured so any participant can share.)

When a participant launches presenter, the desktop is outlined in a red frame.

The participant can adjust the display sharing settings to accommodate different display 
resolutions and select a specific application to share.

ShoreTel supports two presenter applications:

• ShoreTel Presenter for Windows

• ShoreTel Presenter for Java

They provide the same basic features and functions.

5.2 ShoreTel Presenter for Windows
ShoreTel Presenter for Windows can present PowerPoint presentations.

ShoreTel Presenter for Windows also includes a Desktop Accelerator that can optimize the 
rendering of shared pages.

5.2.1 Presenter for Windows Installation Requirements
• ShoreTel Web Conferencing service

• A web browser:

• Microsoft Internet Explore 9.0

• Firefox 12.0 (supports Windows and Mac operating systems)

• Safari 5.0

• Adobe Flash 9 or later

• Java 1.6.0.15 Runtime Environment or later
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5.2.2 Install ShoreTel Presenter for Windows

Step 1 Download the Java RunTime Environment.

Step 2 Install Presenter.

5.2.3 Install ShoreTel Presenter for Windows using ShoreTel 
Conference Web Portal
Download and install ShoreTel Presenter for Windows on the computer used for desktop 
sharing (if Presenter for Windows is not pre-installed via Communicator).

Presenter for Windows can be downloaded from your company ShoreTel conference Web 
portal:

Step 1 Launch your Web browser.

Step 2 In the address field, type the URL for your company ShoreTel conference Web 
portal.

(If you do not know the URL, contact your ShoreTel system administrator.)

The Public tab of the ShoreTel conference Website is displayed (Figure 5-1).

Step 3 Click Download.

The Download page is displayed (Figure 5-2). You can also access this page from 
the My Conference tab by clicking Download Presenter Software.

Step 4 Click Download ShoreTel Presenter.

The File Download Security Warning dialog box is opened.

Step 5 Click Run.

Step 6 Presenter for Windows is downloaded.

The ShoreTel Presenter Installation Wizard is opened. 

Step 7 Follow the prompts.

Figure 5-1 ShoreTel Conference Web Portal Public Page
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Figure 5-2 Download Page for ShoreTel Presenter
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5.3 ShoreTel Presenter for Java
• Provides an alternative way to share a desktop on Windows, without having to install 

any software.

• Provides the only way to share Mac desktops.

• Can be used on Windows desktops, but a special keyboard sequence is required.

• Includes a Sharing Rectangle that can be moved about the screen, allowing desktop 
sharing on a secondary monitor or across multiple monitors.

• Does not have a Preview screen.

• Does not include a Custom sharing rectangle.

5.3.1 Presenter for Java Installation Requirements
• ShoreTel Web Conferencing service

• A web browser:

• Microsoft Internet Explore 9.0

• Firefox 12.0 (supports Windows and Mac operating systems)

• Safari 5.0

• Adobe Flash 9 or later

• Java 1.6.0.15 Runtime Environment or later.

This software must be downloaded on a participant’s computer to participate in 
desktop sharing.

5.3.2 Install ShoreTel Presenter on Mac

Step 1 Download the Java RunTime Environment.

Step 2 Install Presenter.



Chapter 5: Conference Presenter Conferencing User Guide

ShoreTel 13 87

5.4 ShoreTel Presenter
• Launching Presenter

• Presenter Features

5.4.1 Launch Presenter

Step 1 Join a conference as the host, or join a conference that allows all participants to 
share the desktop.

Step 2 In the Start Sharing Desktop page, click the button to start sharing your desktop.

The ShoreTel Presenter Software dialog box is opened (Figure 5-3).

NOTE To launch an alternative presenter, press Shift and click the button to 
start sharing your desktop.

Step 3 Select a default ShoreTel Presenter:

• Click Windows Presenter.

This is recommended for computers using Windows.

• Click Java Presenter.

You must select this option for Mac computers. You can also use this option 
for Windows computers.

Step a Click Remember my selection.

Your selection is used as the default presenter launched on this computer for 
desktop sharing.

Step b Click OK.

NOTE If you see a pop-up security warning, click continue or allow.

ShoreTel Presenter for Windows is opened (Figure 5-4).

ShoreTel Presenter for Java is opened (Figure 5-5).

The sharing area is enclosed in a red border.
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Figure 5-3 ShoreTel Presenter Software Dialog Box

Figure 5-4 ShoreTel Presenter for Windows
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Figure 5-5 ShoreTel Presenter for Java 
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5.4.2 ShoreTel Presenter Icons
Figure 5-6 ShoreTel Presenter for Windows Icons

Figure 5-7 ShoreTel Presenter for Java Icons

5.4.2.1 Pause Sharing
Figure 5-8 Pause Icon

5.4.2.2 Start Sharing
Figure 5-9 Start Sharing Icon

5.4.2.3 Close Presentation
Figure 5-10 Close Icon

5.4.2.4 Presenter Menu

The Presenter menu for Windows is different from the Presenter menu for Java. 

Figure 5-11 Show Menu Icon
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ShoreTel Presenter for Windows Drop-down Menu

Figure 5-12 ShoreTel Presenter for Windows Drop-down Menu

Table 5-1 ShoreTel Presenter for Windows Show Menu Options

Start Sharing Start (or resume) desktop sharing.

Pause Sharing Pause sharing.

Disable Desktop Accelerator 
(SDA)

The Deskshare Accelerator (SDA) helps render conference content. It is installed with ShoreTel 
Communicator for Windows. (It can also be installed independently.) If SDA conflicts with other 
accelerator programs installed on your computer, nothing is shared. Disable SDA under these 
circumstances.

Refresh Rate • Low (low bandwidth).

• Medium.

• High (high bandwidth).

Image Quality • Low (low bandwidth).

• Medium.

• High (high bandwidth).

My Screen Resolution • Original (default).

• 1024 × 768.

• 800 × 600.

Show More Menu Expand or contract menu options.

Sharing Help Help system.

Close Close Presenter; end desktop sharing.
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ShoreTel Presenter for Java Drop-down Menu

Figure 5-13 ShoreTel Presenter for Java Drop-down Menu

Table 5-2 ShoreTel Presenter for Java Drop-down Menu Options

5.4.3 Choose Sharing Window
The sharing area is automatically adjusted when the presenter screen-size setting is changed.

The size and position of the sharing area can be manually adjusted.

NOTE This option is not available in ShoreTel Presenter for Java.

Figure 5-14 Choose Sharing Window Icon

Table 5-3 Choose Sharing Window Options

Start Sharing Start (or resume) desktop sharing.

Pause Sharing Pause sharing.

Image Quality • Low (low bandwidth).

• Medium.

• High (high bandwidth).

Sharing Size • Entire screen (at default resolution).

• 1024×768, 800×600, 640×480.

Close Close Presenter; end desktop sharing.

Rectangular Area Change the size of the presentation area. By default, the rectangle is placed in the center 
of the screen. Drag-and-drop to adjust the size and position of the rectangle.

Entire Screen The default.

Applications Currently Open Click an application to display it in Presenter. Only the selected application is displayed.
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5.4.4 Select Sharing Area
The default sharing area is the entire screen. It can be reduced to a smaller area. 

The sharing area displays one application at a time.

5.4.4.1 Specify an Application to Display in ShoreTel Presenter for Windows

Step 1 Click Choose Sharing.

The menu is displayed (Figure 5-15).

Step 2 Select an application

The application is outlined in red.

Figure 5-15 Chose Sharing Drop-down Menu
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5.4.4.2 Modify Sharing Area in ShoreTel Presenter for Windows

Step 1 Click Choose Sharing.

The menu is displayed (Figure 5-15).

Step 2 Click Rectangular Area.

The sharing area is displayed in the middle of the screen.

The icons are located in the top, left-hand corner. 

Step 3 To move the sharing area:

Step a Place the cursor on the border.

The Move tool is opened.

Step b Hold down the right mouse button, then drag the sharing area to another 
position.

Step 4 To modify the size of the sharing area:

Step a Place the cursor in one of the corners.

The double-arrow Move tool is opened.

Step b Hold down the right mouse button, then stretch or shrink the sharing area.

5.4.4.3 Reposition Sharing Area in ShoreTel Presenter for Java

In ShoreTel Presenter for Java, you can reposition the sharing area when changing the 
resolution.

Only content displayed in the frame on the sharing desktop is broadcast to conference 
participants.

Step 1 Click Show Menu.

Step 2 Select Sharing Size, then select the resolution.

The sharing area is refreshed in the center of the desktop.

Step 3 To reposition the sharing area:

Step a Place the cursor on the border.

The Move tool is opened.

Step b Hold down the right mouse button, then drag the sharing area to another 
position.
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5.5 Setting Sharing Resolution
By default, the entire desktop is shared using the resolution configured for the display of the 
sharing computer.

For example, if the resolution of the sharing computer is 1280×1024, the resolution of the 
shared desktop is 1280×1024.

Participants using displays set for a different resolution experience resolution mismatch. 
Participants using higher resolution receive the image as sent, with reduced detail. Participants 
using lower resolution may experience degraded image quality.

To accommodate lower resolution, Presenter allows participants to temporarily override the 
display resolution settings of the sharing computer. When the override is invoked, Presenter 
changes the current display resolution. When Presenter is closed, the resolution reverts to the 
configured setting.

The image exported by Presenter is displayed in a frame in the Web conference session page.

5.5.1 Change Resolution of ShoreTel Presenter for Windows

Step 1 Click Show Menu.

The menu is displayed.

Step 2 Select My Screen Resolution > resolution value.

The resolution value applies to the conference.

The screen refreshes to the selected resolution.

Images on the desktop are recalibrated to the new resolution.

Participants see the sharing area.

If necessary, resize the presented application to ensure that participants can see an 
entire image.

All opened applications are automatically resized to the new resolution.

5.5.2 Change Resolution of ShoreTel Presenter for Java

Step 1 Click Show Menu.

The menu is displayed.

Step 2 Select Sharing Size > resolution value.

The resolution value applies to the conference.

The screen refreshes to the selected resolution.

Images on the desktop are recalibrated to the new resolution.

Participants see the sharing area.

If necessary, resize the presented application to ensure that participants can see an 
entire image.

All opened applications are automatically resized to the new resolution.

The resolution of the sharing computer is unaffected.
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5.6 Adjusting Quality of Shared Image
Presentations requiring frequent screen updates (such as animation) often use large amounts of 
bandwidth.

Many factors can affect the quality of the image displayed to participants.

Presenter provides options for improving the participant experience, including adjusting the 
outgoing refresh rate and bandwidth of the sharing source.

NOTE Actual adjustment depends on the input from the source, and can be negligible.

5.6.1 Adjust Outgoing Refresh Rate (Presenter for Windows only)

Step 1 Click Show Menu.

The Show Menu drop-down menu is opened.

Step 2 Select Refresh Rate:

• Low: half the current rate.

• Medium: current rate.

• High: 1.5x the current rate.

5.6.2 Adjust Outgoing Bandwidth (Presenter for Windows & 
Presenter for Java)

Step 1 Click Show Menu.

The Show Menu drop-down menu is opened.

Step 2 Select Image Quality.

• Low: half the current rate.

• Medium: current rate.

• High: 1.5x the current rate.
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C H A P T E R 6

Conference Viewer

6.1 Introduction
The conference viewer allows the host and participants to join and manage conferences.

The host uses the conference viewer to manage the conference.

Participants can use the Web page to interact with the host and view the data shared in the 
conference. 

This chapter provides information about the Web conference page.

Topics include:

• Host Web Conference Page section on page 97

• Share Menu section on page 99

• More Menu section on page 102

• Participant Panel section on page 106

• Audio Conference Options section on page 107

• Participant Web Conference Page section on page 109

• Sharing section on page 110

6.2 Host Web Conference Page
Figure 6-1 shows the Web conference page of the conference host.

Table 6-1 describes the host Web conference page.



Conferencing User Guide Chapter 6: Conference Viewer

98

Figure 6-1 Host Conference Viewer

Table 6-1 Host Conference Viewer Details

1 Share Specify the application to share with conference participants.

2 Stop Desktop Sharing Stop data sharing without closing Web conference.

3 More Options for managing conference.

4 Conference Information Displays conference details.

5 Number of Web Attendees Participants logged in to Web portion of conference.

6 Number of Audio Attendees Participants logged in to audio portion of conference.

7 Help Conference help system.

8 Information Conference details.

9 Participant Conference participants.

10 Participant Options Participant options.

11 Audio Conference Options Audio conference options.

12 Name Names of participants.

13 Phone Phone number of audio participants and caller ID of Web-only participants.

14 Message Displays text and other messages sent during conference.

15 Message Enter and send text to conference participants.

16 Send to Specify participant to send message.
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6.3 Share Menu
This menu is available to the host or participants with permission to share.

From here, designated hosts and participants specify what to share with other conference 
participants.

6.3.1 Display Share Menu

Step 1 Join a conference as the host (or receive permission to present).

The Share menu is displayed on the toolbar.

Step 2 Click Share.

The Share menu is opened (Figure 6-2).

Figure 6-2 Share Menu

Table 6-2 Share Menu Options

Entire Desktop Launch Presenter and share your desktop with conference participants.

Personal Library Share material uploaded to your personal conference library.

Shared Library Share material uploaded to the shared conference library.

Send File Send a file as a message to conference participants. Participants can choose to open the 
message or save it.

Whiteboard Use conference page as a whiteboard. Whiteboard tools are available for the presenter 
only.

Import Presentation Import Powerpoint presentations into conference. You must first stop sharing to import 
the presentation. After a presentation is uploaded, sharing starts automatically.
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6.3.2 Share Desktop
Conference participants (including the host) who are presenting can share their desktop.

NOTE To share the desktop, your computer must be running ShoreTel Presenter for Windows 
or Java Runtime Environment 1.6.0.15 or later.

6.3.2.1 Enable Sharing as a Host

Step 1 Join a conference as the host.

Step 2 Click Share > Entire Desktop, or the sharing button.

After a few seconds, the Presenter frame is displayed around the desktop.

6.3.2.2 Transfer Sharing to a Participant

Unless the conference is configured to allow participants to share when they join, the host 
must grant share privilege to participants.

When sharing is granted from the beginning of a conference, the host can revoke and restore 
the share privilege.

Step 1 Join a conference as the host.

Step 2 In Participant, select a participant.

The participant must have a Web connection.

Step 3 Click Participant options.

The Participant options menu is opened.

Step 4 Click Allow presenting.

A dialog is opened on the desktop of the participant noting that the host is granting 
Presenter control.

The participant must click OK to complete the transfer.

6.3.2.3 Enable Sharing as a Participant

Step 1 If you are granted permission to present, the Share Desktop dialog is opened on 
your desktop and the Share menu is displayed on your toolbar (Figure 6-3).

Step 2 Click Yes.

NOTE If another participant is currently presenting, a second dialog is opened, 
identifying the presenter and allowing you to stop the sharing. Click 
Stop.

The Share Desktop dialog is displayed in the middle of the conference viewer 
(Figure 6-4).

Step 3 Click the start sharing button.

After a few seconds, the Presenter frame is displayed around the desktop.
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Figure 6-3 Share Desktop Message Box

Figure 6-4 Share Desktop Command in Participant Browser
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6.4 More Menu
This menu is available to the host or participants with permission to share.

From here, designated hosts and participants manage audio participants.

NOTE This menu does not apply to audio callers using ShoreTel Communicator to access the 
Web page.

6.4.1 Display More Menu

Step 1 Join a conference as the host.

Step 2 Click More.

The More menu is opened (Figure 6-5).

Figure 6-5 More Menu
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Table 6-3 More Menu Options

6.4.2 Send Email Invitations
The conference host can send email invitations from a conference session.

The invitation uses the ShoreTel email template, which includes dialing and access 
information for the current conference. Text can be edited.Join a conference as the host.

Step 1 Click More > Send Invitation.

The Send Invitation dialog is opened (Figure 6-6).

Step 2 Enter email addresses (separate addresses with commas).

Step 3 Enter text.

Step 4 Click Send Email to use the email server of the ShoreTel system to send the email. 
Or, click Send From Default Email Application to use the default email 
application installed on the current computer to send the invitation.

Step 5 Click Cancel to close the dialog and discard the email.

Option Description
Mute All Place all participants on mute. Host, if present on call, is never muted by this function.

Unmute All Undo mute.

Call Participant Dial number of participant to join the audio conference associated with current Web 
conference. 

Call Me Dial your extension to join audio conference associated with current Web conference.

Send Invitation Send e-mail invitation to join conference. Invitation includes conference information 
automatically. You must enter the e-mail addresses of participants.

Record Conference Record conference.

Locked Conference Limit conference participants to those already in attendance. Those trying to join locked 
conferences receive a prompt indicating that conference is closed to new participants.

Restart Conference Restart the conference. Current members are re-entered automatically.

Note: If host service appliance is operating at capacity for Web user when host restarts 
conference, Web participants are redirected to ShoreTel conference Web portal and 
receive the error message: “Web capacity is full on this Service Appliance. Please try 
again later.” Participants must manually re-enter Web session.

End Conference End conference.
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Figure 6-6 Send Invitation Dialog Box

6.4.3 Record Conferences
The host can record conferences.

A recording can be started and stopped at any point during the conference, and multiple 
recordings can be made of the same conference.

Each recording is assigned a recording ID and listed under the recording tab in the Web 
conference portal for the conference.

Both audio and Web portions of the conference are recorded.

NOTE You can record up to eight consecutive hours in a conference.

6.4.3.1 Start a Recording from a Web Conference Page

Step 1 Join a conference as the host.

Step 2 Dial into the conference, or make sure that someone has dialed into the 
conference.

NOTE You must stop ShoreTel desktop sharing or any streaming application 
before you can start recording.

Step 3 Click More > Start Recording:

An audio prompt informs participants that the call is being recorded.

When there is no audio session, a dialog is opened informing you, the host, that 
only a Web session is being recorded. Even if a caller joins the conference later, 
the system records the web portion only. Click OK to continue. 

When desktop sharing is in progress, a dialog is opened informing you that 
desktop sharing must be stopped or paused to start the recording. Click OK to stop 
desktop sharing. After the recording starts, resume desktop sharing.

Step 4 The recording is started.

The Stop Recording button is displayed on the menu bar.
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6.4.3.2 Stop a Recording From a Web Conference Page

Step 1 Click More > Stop Recording, click Stop Recording.

The stop recording dialog is opened (Figure 6-7).

Step 2 Click OK.

A confirmation dialog is opened (Figure 6-8).

NOTE When you stop a recording, only the recording is stopped; the audio and 
Web conference continue. 

Figure 6-7 Stop Recording Message Dialog Box

Figure 6-8 Stop Recording Confirmation Message

6.4.3.3 Start and Stop a Recording Using a Phone

A host can start and stop recording using the keypad of a ShoreTel phone.

Both audio and Web portions of the conference are recorded.

Step 1 Join the conference as the host.

Use the host access code when dialing into the conference.

Step 2 On the telephone keypad, press # then 4.

A prompt informs all of the audio participants that the conference is being 
recorded.

Step 3 To stop the recording, press # then 4.

A prompt informs all of the audio participants that the recording has stopped.
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6.5 Participant Panel
This pane shows the names of conference attendees.

The Participant Panel on the host desktop shows how participants joined the conference.

From here, the host can manage participants.

6.5.1 Participant Options
The Participant Options allow the host to manage the Web session of a selected participant. 
(The participant must have an established Web connection.)

The host can manage desktop sharing and whiteboard use.

The host can also end the Web session of a participant.

Step 1 Log into a conference as the host.

Step 2 In the Participant panel, select a Web session participant.

The Participant Options are enabled.

Step 3 Click Participant Options.

The Participant Options drop-down menu is opened (Figure 6-9).

Step 4 Click an option (Table 6-4).

It is applied to the participant, and the icon for the option is posted next to the 
name of the participant in the Participant panel.

Figure 6-9 Participant Options Icon Drop-down Menu

Table 6-4 Participant Options

Allow presenting Allow participant to present.

Discontinue presenting End participant presentation.

Allow drawing Allow participant to use whiteboard. (Host must enable whiteboard first.)

Discontinue drawing End participant whiteboard use.

Remove participant Remove participant from conference Web session.
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6.6 Audio Conference Options
The Audio Conference Options allow the host to manage the audio portion of the conference 
for a selected participant.

The host can call members to join the audio session, and manage the audio of a selected 
participant.

6.6.1 Invite a Participant to an Audio Conference

Step 1 Log into a conference as the host.

Step 2 In the Participant panel, click Audio Conference Options.

The Audio Conference Options menu is opened (Figure 6-10).

Step 3 Click an option.

A dialog is opened (Figure 6-11).

Step 4 Enter the number of the party.

Step 5 Click OK.

The system dials the number.

Figure 6-10 Audio Conference Options Menu

Figure 6-11 Call Option Dialog Box: Call Participant
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6.6.2 Manage Audio Connection of a Participant

Step 1 Log into a conference as the host.

Step 2 In the Participant panel, select an audio session participant (as indicated by a 
phone next to the name of a participant).

Step 3 Click Audio Conference Options.

The Audio Conference Options drop-down menu is opened (Figure 6-9, and Table 
6-5).

Step 4 Click an option.

It is applied to the participant.

Table 6-5 provides information about the Audio Conference Options menu.

Figure 6-12 Audio Conference Options Menu

Table 6-5 Audio Conference Options

Call Me Dial phone number of host to attend audio session of conference.

Call Participant Dial participant s to attend audio session of conference.

Mute Phone Mute phone of participant. 

Unmute Phone Unmute phone of participant. 

Hang up Hang up phone of participant.
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6.7 Participant Web Conference Page
Figure 6-13 shows the Web conference page of the conference host.

Table 6-6 describes the host Web conference page.

Figure 6-13 Web Conference Page for Participant with Share Capability

Table 6-6 Web Conference Page for Participants with Share Capability

Share Menu Allows host to specify application shared with conference participants. Available only when host 
grants permission to participant to share desktop.

Stop Desktop Sharing Stops sharing, without closing Web conference. Available only when host grants permission to 
participant to share desktop.

Mute Mute phone.

Raised Hand Draw host's attention.

Call Me Conference dials participant phone number.

Conference Information Displays information about conference.

Login (into Web portal) Take host control of your own conference

Help Help system.

Information Information about conference and host.

Participant Lists conference participants and shows status participant participation.

Name Participants names.

Phone Lists phone numbers of audio participants and caller ID of Web-only participants.

Message (pane) Displays text and other messages sent during conference.

Message (field) Enter text sent to conference participants.

Send to Name of conference participant.
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6.8 Sharing

6.8.1 Download Library File for Conference
Conference presenters can download files stored in the ShoreTel Web conferencing library to 
share with participants. The files can reside in your personal library or the shared library. 

Step 1 Join the Web session of a conference.

NOTE If you are not the host of the conference, you must sign in to access files 
in your personal library. You are reconnected to the conference with a 
new status.

Step 2 Obtain presenter privilege.

The Share menu is opened on your conference viewer.

Step 3 Click Share.

The Share menu is opened.

Step 4 Click the library type.

NOTE If you are not the host, you must sign into the conference before the 
Personal Library option is opened.

Step 5 Click a file.

The file is opened and is displayed in the conference viewer.

6.8.2 Send a File
You can send a file to participants for viewing or downloading at their convenience during the 
conference.

Step 1 Join a conference and secure share privileges.

Step 2 Click Share.

The Share menu is opened. 

Step 3 Click Send File.

The Select a file to upload dialog is opened.

Step 4 Select a file.

Step 5 Click Open, Download, or X.

Open: file is opened on the computer.

Download: file is downloaded to current computer.

X: Dialog is closed.

NOTE You can access the file any time during the conference by clicking the 
link.
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6.8.3 Importing Presentations
• The Import Presentation option allows you to import PowerPoint files into the 

whiteboard. From there, you can mark presentations in real time.

• When a PowerPoint file is imported, the slides are transferred to the whiteboard in the 
conference session.

• The whiteboard tools are displayed with presentation slides on the conference page.

• The conference toolbar is modified to allow you to select a PowerPoint slide for 
display.

• All participants can use whiteboard tools to select and mark displayed slides.

• Modifications made to the slides using the whiteboard tools are retained as long as the 
conference is in session.

• The presenter can import multiple PowerPoint files for a single conference session.

• The names of the files imported by the presenter are listed in the Share menu of the 
presenter only.

• Only one file at a time is loaded for viewing into the conference viewer.

• Files can be used as long as the conference is in session, even if the presenter leaves.

6.8.3.1 Import and use PowerPoint File in Web Conference Session

Step 1 Join a conference and secure share privilege.

Step 2 Click Share.

The Share menu is opened. 

Step 3 Click Import Presentation. 

The Select File dialog is opened.

NOTE You may be prompted to stop desktop sharing. If so, click OK; click 
Stop (on the toolbar); then click Share > Import Presentation.

Step 4 Select a PowerPoint file.

PowerPoint is launched in the background on the computer and the presentation 
slides are loaded and integrated into the whiteboard in the conference session 
(Figure 6-14).

NOTE After the slides are loaded, you can close the PowerPoint application.

When multiple PowerPoint presentations are uploaded, the presenter must select 
the file as follows: Click Share, then select the file.
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Select a Single Slide for Display

Step 1 On the toolbar, navigate to the slide select.

Step 2 In the page field, click and select a page.

The page is displayed.

Using the Whiteboard

Step 1 Click a whiteboard tool.

Use the tool.

Adjust Size of Presentation

Step 1 Click Size on toolbar (on right side of the page).

Step 2 Select a page size.

The view on your computer is adjusted.

Figure 6-14 Integrated Web Conference Page with Whiteboard and PowerPoint Slide\
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C H A P T E R 7

Instant Conference

7.1 Introduction
Install one of the following on ShoreTel Communicator computer for presentation:

• ShoreTel Presenter for Windows

• Java Run Time Environment 1.6.0.15 or later

7.1.1 Set up Data Collaboration Session

Step 1 Establish a call with ShoreTel participants.

Step 2 Call participants launch ShoreTel Communicator on their computers.

Step 3 One user, the host, clicks the Start Instant Conference icon on the bar in 
Communicator showing the call as shown in Figure 7-1. (You can also click Call > 
Start Instant Conference on the toolbar.)

A link for the conference appears in the call cell as shown in Figure 7-2. The link 
shows the Web address and the conference ID number. Also, if configured to do 
so (the default value), the link is automatically activated on all participant 
machines and the conference viewer is launched as shown in Figure 7-3.

NOTE If the ShoreTel conference viewer does not automatically appear, click 
the link to launch it.

Step 4 Click the start button in the conference viewer to start desktop sharing. Control of 
the desktop can be transferred to another user at any time.

The Launch Application dialog box appears as shown in Figure 7-4.

Step 5 Do one of the following:

• Click VPresent to share your desktop.

• Click Choose button to select the application that you want to share.

Click OK. ShoreTel conference presenter launches. The conference presenter 
appear as thick border that encases your desktop or the application you select as 
shown in Figure 7-5. The conference presenter appears in the Web page that is 
launched when participants join the Web conference.

NOTE The desktop or application that you are sharing is encased in a thick 
border with four buttons at the top center. The buttons allow you to 
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pause sharing, close sharing, show the share menu, and choose a 
specific window to share.

Figure 7-1 ShoreTel Communicator with Start Instant Conference Icon

Figure 7-2 ShoreTel Communicator with Conference Web Link



Chapter 7: Instant Conference Conferencing User Guide

ShoreTel 13 115

Figure 7-3 ShoreTel Communicator Conference Viewer

Figure 7-4 Launch Application Dialog Box

NOTE Check “Remember my choice for stpresent links” to save time and avoid security 
dialog from browser.
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Figure 7-5 Viewer Frame

reminders:

Instant Conference do not show up in the web portal

recording only gives web portion and never audio

there is no way to call into an instant conference
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C H A P T E R 8

Microsoft Outlook Integration

8.1 Introduction
ShoreTel conferencing integrates with Microsoft Outlook 2007 Calendar and Microsoft 
Outlook 2010 Calendar to allow you to create and post ShoreTel conferences in the Microsoft 
Outlook calendar.

This chapter describes how to install the ShoreTel module in the Microsoft Outlook calendar 
and how to use the module to create and access ShoreTel conferences.

Topics include:

• "Integrating with Microsoft Outlook Calendar"

• "Creating a Conference in Outlook"

• "Joining a Scheduled Conference from Outlook"

• "Delete Conference Component from Outlook Meeting"

• "Changing Conference Settings in Outlook"

• "Integrating with Microsoft Outlook Calendar"

8.2 Integrating with Microsoft Outlook Calendar
Step 1 Close Microsoft Outlook.

Step 2 Launch ShoreTel Communicator.

Step 3 On the toolbar, click Tools > Options (or, click the ShoreTel logo and select 
Options in the drop-down menu).

The Options and Preferences window is opened.

Step 4 In the menu, click Outlook.

The Outlook page is opened (Figure 8-1).

Step 5 In the Calendar section, click Install.

NOTE If Outlook is open, the Shutdown Application pop-up is opened. You 
can close Outlook or leave Outlook open. Click Ignore. If Outlook is left 
open, you must close and re-open it for the install to take effect. When 
Outlook is re-opened, the ShoreTel Conference application is displayed 
on the toolbar of the Action tab in the Microsoft Calendar.
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Figure 8-1 Options and Preferences Window with Calendar Install Option

Figure 8-2 Microsoft Calendar Appointment Tab with ShoreTel Conference Application
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8.3 Creating a Conference in Outlook
Two types of conferences can be scheduled in Outlook:

• One-time appointments that occur on a single date and time.

• Recurring appointments that occur over a period of time.

NOTE Conferences created in Outlook that have a duration of more than eight hours are 
displayed in the ShoreTel conference Web Portal with a duration of eight hours.

8.3.1 Create a Conference on ShoreTel Service Appliance in Microsoft 
Outlook

Step 1 Launch Microsoft Outlook.

Step 2 In the navigation bar, click Calendar.

Step 3 In the menu bar, select Action > New Appointment

A blank Appointment window is opened.

Step 4 Set the parameter for the meeting.

Step 5 Click Conference (in ShoreTel application listing).

Step 6 Click Create.

A ShoreTel conference is created with a unique conference ID.

The conference ID, dial-in number, and other conference information is included 
in the e-mail message sent to invitees and in the calendar posting created when the 
message is sent.

Step 7 Click Send.

Conferences created in Outlook are displayed in the ShoreTel conference Web 
portal. These conferences cannot be modified or deleted using the ShoreTel 
conference Web portal.

Recurring conferences created in the ShoreTel conference Web portal are not 
displayed in the Outlook calendar.
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8.4 Joining a Scheduled Conference from Outlook
Step 1 Launch Microsoft Outlook.

Step 2 In the navigation bar, click Calender.

Step 3 Double-click a listed meeting.

The Meeting window is opened.

Step 4 Click Join Conference (in the Outlook ribbon).

An Internet browser is launched, and the Web page for the conference is opened.

The Audio Conference dialog is also opened, showing the dial-in number and 
access code for the conference.

Step 5 Click More Dial Info.

The in-house extension for conferences is listed.

The external phone number for the conference is also listed.

These numbers connect you to the audio portion of the conference.

Step 6 If you are the conference host or presenter, click Start to share your desktop.

8.5 Delete Conference Component from Outlook Meeting
You can remove a conference without deleting the meeting from Outlook.

8.5.1 Delete Conference from Outlook

Step 1 Launch Microsoft Outlook.

Step 2 In the navigation bar, click Calender.

Step 3 Double-click a listed meeting listing.

The Meeting window is opened.

Step 4 Click Conference (or click the ShoreTel icon then click Delete). 

The meeting is deleted from the conference schedule but remains in Outlook as a 
meeting.
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8.6 Changing Conference Settings in Outlook
The following settings can be specified:

• conference ownership and access

• conference starting points

• conference record commentators

• password entry

• participant entrance and exit signals

8.6.1 Set Conference Parameters

Step 1 Launch Microsoft Outlook.

Step 2 In the navigation bar, click Calendar.

Step 3 Double-click a listed meeting.

The Meeting window is opened.

Step 4 Click ShoreTel Conference.

A drop-down menu is opened.

Step 5 Click Settings.

Conference Settings window is opened (Figure 8-3).

Step 6 Enter Host Code.

Step 7 Enter Participant.

Step 8 Enter My extension (ShoreTel extension of the Host).

Step 9 Click Advanced Options.

Step 10 Select conference parameters (Table 8-1).

Step 11 Click OK.
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8.6.1.1 Conference Parameters: Notes

Note 1

When a change is made in Outlook to the properties of a recurring meeting, the only item the 
user can change is the subject of the meeting (not the date or time), because it is considered a 
reservationless conference. (Outlook prompts, “This is a recurring appointment, do you want 
to open only this occurrence or the series?”)

A change of subject made to a single occurrence (for example, time or day of week) is applied 
to the entire series in the ShoreTel Conference Web Portal, even though Outlook reflects only 
the change to the single occurrence.

Note 2

When a recurring meeting is scheduled through Outlook, it is displayed in the ShoreTel 
Conference Web Portal under the Reservationless conference list.

If a recurring meeting is later changed into a scheduled meeting, the meeting is not moved to 
the Scheduled Conference list, even though the meeting type is different.

Note 3

If you do not want to change the entire series or display a meeting appear in an incorrect 
meeting list, delete and then recreate the meeting with the correct details or meeting type.

Note 4

Changes to the options do not take effect while the conference is in session.

You must stop/start a conference for options to take effect.

Outlook created cons cannot be edited by the Web Portal.



Chapter 8: Microsoft Outlook Integration Conferencing User Guide

ShoreTel 13 123

Figure 8-3 Conference Settings Window with Advanced Options Expansion

Table 8-1 Conference Settings Options

Conferencing

Start the conference only when I join Conference starts after you, the host, join. Participants who dial in early are put on hold 
until you join conference.

Start the conference only when I join 
and list my conference in the Public 
page

Conference starts after you, the host, join. Conference is listed under your name in 
conference Web page on Public tab.

Start the conference only when anyone 
joins

Conference starts after someone dials in.

NOTE: For security, do not make conferences with these settings public.

Start the conference when anyone joins 
and make everyone a presenter

Conference starts after someone dials in, and any participant can present.

NOTE: For security, do not make conferences with these settings public.

Comments

Allow public comments Anyone can make conference comments.

Private comments only Participants must send comments to host for inclusion in conference comments.

Disable comments No comments allowed.

Access

Use a conference password Participants must use a password to enter conference. Enter password for participants.

Entry and exit tone

None No tone is used to indicate participant entry or exit.

Tone Tone is used to indicate participant entry or exit.

Detailed Participant is prompted for name when entering or exiting.
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8.7 Uninstalling ShoreTel Calendar Integration Tool in 
Outlook
The calendar integration tool in Microsoft Outlook does not schedule conferences when the 
user is switched from a ShoreTel Converged Conferencing bridge to a ShoreTel Service 
Appliance.

In order to re-enable the conference scheduling feature after such a switch, you must uninstall 
then re-install Outlook Calendar integration.

8.7.1 Uninstall Integration with Outlook Calendar for ShoreTel 
Converged Conferencing

Step 1 Launch ShoreTel Communicator.

Step 2 On the toolbar, click Tools > Options (or click the ShoreTel logo and select 
Options in the drop-down menu).

The Options and Preferences window is opened.

Step 3 Click Outlook.

Under Calendar, click Uninstall.

NOTE If Outlook is open, the Shutdown Application pop-up is opened. You 
can close Outlook or leave Outlook open. Click Ignore. If Outlook is left 
open, you must close and re-open it for the uninstall to take effect.

When Outlook is re-opened, the ShoreTel Conference application is no longer 
displayed on the toolbar of the Action tab in Microsoft Calendar.
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A P P E N D I X A

Telephone Commands for Audio
Controls

Table A-1 Telephone Command Key Sequences

Turn hold music on and off #1

List commands and their corresponding key 
sequence #8

Mute/unmute own audio #1

Host mutes/unmutes audio of participants #2

Host dials out to add participant

Host can start and stop recording conference #4

Host can lock/unlock conference so 
additional participants cannot join. #5

Host ends audio and web conference #99
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